Customizing Your F7NP
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SETTINGS

«@ @@ A

DST Frequency QK

P @,

Formatre...

Date/Time  TimeZone

@ =

3/4 ClickTone ~ Screen...

Parking...

Date / Time
Time Zone
DST
Frequency
Click Tone

Screen Saver

Parking Mode

Format-Reminder

> Update With GPS

> Choose Your Time Zone

> Daylight Saving Time ON/OFF

> 60HZ/50HZ

> ON/OFF

> Off/10s/30s/2mins. Screen go off

after the set time.

> Please connect the ACC hardwire kit

> Remind to Clear Data

18




Customizing Your F7NP
I e — et

SETTINGS

"® 8 ¢ 0°

Format  Cardspeed DefaultSetting  Version

474 Help Center v

MicroSD Card Format > Clear MicroSD card data

Card-Speed > Card Speed Detection
Default Setting > Reset All Settings
Version

> Software Version

Help Center > Scan the QR code to contact us

POP-UP: 1. In order to a Clean, Smooth, Comfortable using experience,
we suggest you format your MicroSD card once a month.

2. If there is no GPS signal, or if the GPS has a signal but the stamp is not
turned on, you will not be able to see the real-time route of the vehicle.
3. Since dash cam has a built-in GPS function, it will automatically
update the time according to your location and time zone, so you don't
need to change the time manually. However, you can adjust daylight
saving time via DST.

4.When you turn off Click Tone, the startup and shutdown sounds will
also be turned off.

19



Parking Mode ( Optional )
I e — et

PREPARE YOUR HARDWIRE KIT

Hardwire Kit is needed only when using Parking Mode.
If Parking Mode is desired, contact Redtiger to purchase.
GETTING TO KNOW YOUR HARDWIRE KIT

Features: -
> Low Battery Voltage Protection :’_[_—'U_l H

> Multi Input Power
> Universal Compatibility

> Length: 11.5ft
JU

[SBI=(E

WARNING: Wrong connection may disable Voltage
Protection and damage your car.

INSTALL YOU HARDWIRE KIT

Red wire >ACC > Power only when car key is on
Yellow wire > B+ > Always has power
Black wire > Ground > Any grounded (neg) screw
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Parking Mode ( Optional )
I e — et

U

Engine key

fuse  Adaptive Accessory code {red)
Cruise Control

— =+ BATT
BATT Battery cord (yellow)

Earth cord {black)

battery Connect to metal part of the fuse

box (Negative pole of power supply)

POP-UP: Fuse box panel is typically located driver side dash board.
You could cut the head of wires and connect it to your fuse directly if

fuses is small.

SELECT PARKING MODE

Enter Parking Mode In Settings
Setting > Parking Mode

> off/G-sensor/Time-Lapse 12 h/Time-Lapse 24h/Time-Lapse 48h
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Parking Mode ( Optional )
I e — et

G-SENSOR

> Car off

> The screen prompts "ACC off, then enter GSensor mode." dash
cam power off.

> Collision or vibration be detected

> An Unerasable record will be created in Lock space

TIME-LAPSE

> Select 12h/24h/48h

> Car turn off

> The screen prompts"ACC off, then enter timelapser rec mode."

> The dash cam screen goes black, the red light flashes and the blue
light stays on.

> Time-lapse video is being recorded, saved in a locked folder

POP-UP: 1.1 fps = 1 image during 1 second. G-sensor could be
activated by a deceleration zone.

2. All parking surveillance videos and locked videos are placed in
locked folders. If you find that the video recorded by your dash

cam is choppy, it may be that it was not recording at that time or the
video was put in a locked folder.
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Parking Mode ( Optional )
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Installation Notes

Connection
= ACC
B+

==  Ground

= ACC
No connection
==  Ground

= ACC
ACC

=  Ground

— B+
ACC

— No connection

No connection
Any power
=== Ground

— B+
ACC
=  Ground

Driving

ON

OFF

ON

OFF

OFF

ON
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Parking

Parking Mode \/

OFF

OFF

OFF

ON

OFF
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Parking Mode ( Optional )
I e — et

PARTICULAR WRONG CONNECTION

Connection Driving Parking
= B+
B+ ON Always On

— Ground

> The camera will run Parking Mode constantly, and your car battery
will be drained under this connection.

> The Parking Mode will be working in screen off status. It will begin
recording if there is a collision or vibration triggered by the Sensor.

> Please check if your camera working after 15mins your car is off
(Because some cars have a delayed power-off function, 15 minutes
later you can ensure that the ACC interface has been powered off).

FAQ:

Q1: After installing the hardwire kit, it can enter the parking
monitoring mode, but it cannot be turned on with the car starting,
and the dash cam needs to be turned on manually, why?

A1: Because your hardwire kit's yellow wire is connected to the
wrong place.

Q2: | have installed the hardwire kit, but the dash cam still prompts
that the parking monitoring mode cannot be entered, why?

A2: The first reason is that your red and yellow wires are wired
incorrectly. The second reason is that the red wire of the hardwire kit
is broken and there is no power.
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Connect to the Redtiger App

——— e

DOWNLOAD APP

> Download our "REDTIGER" App from:
https://www.redtigercam.com/pages/app

> Scan QR Code from your F7NP

> Download from Apple APP Store or Google Play Store
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Connect to the Redtiger App
—,—— e

CONNECT YOUR F7NP

(- o )

Wi-Fi WiFi Password: 12345678

> Connect Only This Time

QOn [ @}
or Always connect

Internet may not be available

If you want to connect to this network
without internet access, you can connect
only this time or you can set your phone to
always connect to it even if internet isn't
available.

YYou can change this in Settings >
Connections > Wi-Fi > ADVANCED > Switch

to mobile data > Network exceptions.

Connact only this time
Abways connect

Disconnect

\$ )

POP-UP: This is to avoid series connection between different device.
Some device may prompt that the software contains virus, you could
run the installation as an administrator to download App.
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Home Screen of the Redtiger App
— e

ENJOY APP

1. Return to the
previous step

10. Turn on/off
recorded sound ™\

3. Switch the front
and rear camera
video screens

2.Video stamp

A

11. GPS information

i

< F7N-54ef3366a489

| L cps i

Ws 219°

H—)

0.8

e

7.dash cam file

B 0
[ \

(N

9. Rotate the
video screen

/ left and right

5. Full screen
— display

}\ 12. Map

6. dash cam
) settings

[

4. Pause/start
recording
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Settings Screen of the Redtiger App

——— =

How to View, Download and Delete Video

Click the icon D on the main interface to view video and
picture files.Long press the video file and select it, then choose to
download or delete.

(" [SCMENETAEN mnx&wsm\ (" DT L S REENE 307
< Camera file Select Select All 4 selected Cancel
Loop Snapshot Locked Parking Today

The downloaded files will be move to Local album
Today

4/712022

) g
\\ Download Delete /
N J L J
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Settings Screen of the Redtiger App

——— =

How to View Maps and GPS Tracks

> First make sure your dash cam has a GPS signal and turn on the

GPS stamp.

> Then select the video you want to watch and download it
> Return to the APP home page and select the Album

> Open and watch it

Vs

4 ol R

My Camera ~

F7NP

F7N-a09f103¢9a69

] = O
\ Camera Album More

+

RN ED 504 2

~

%

-
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Redtiger Player

DOWNLOAD REDTIGER PLAYER

Download our Redtiger Player from website:

Transfer your recordings
to computer

ARRRN )
p)

Drag in Redtiger Player




Redtiger Player
—

USE YOUR REDTIGER PLAYER

— Footge Track

Choose to see your
Front / Rear View

See your Speed and Location

USE YOUR REDTIGER PLAYER

Watching Front & Rear
at the same time

»o

Video playoackspeed » O Single channel D video mode

Front \ h

Foider



Maintenance
—

MAINTAIN YOUR CAMERA

Do not directly plug and unplug the cable or MicroSD card, except
when the camera it turned off.

We do not encourage you connection your camera with other
hardwire kit, but if you insist to do this, please have a look of those
lower than 6V and higher than 2.5A.

It is normal for the camera to be warm during operation. Excess

exposure to heat from the sun may cause damage that isn't covered
under the 1 year warranty.
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Trouble Shooting
—— e

WIFI CONNECTION GOES WRONNG

Connection Prepare

> Mobile data/VPN is off

> 16 ft less close to your F7NP

> Only allowed 1 device connection

Connection Notice
> WiFi password: 12345678
> Connect only this time or Always connect

Won't enter Parking Mode

> Hardwire kit needed

> The screen prompts "ACC disconnected" when trying to enter
Parking Mode

> Blue light on + Red light flash

Camera always on after Car turned down

> Wrong connection of Red wire and Yellow wire
> Please connect red wire with ignition fuse

Mass storage prompt on screen

This prompt will appear if you use a USB cable with data transfer
mode to connect external power sources such as dash cam and
laptop. At this point, your dash cam enters the data transfer mode
and cannot be operated like a U disk, but you can directly see the
video recorded by the dash cam on the computer.
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Trouble Shooting
—

Over Heat
> Camera should stay between -4°F- 158°F
RECEIVED DEAD CAMERA ?

Use USB cable to connect your camera with computer and check if
the screen turn on

> If not, please unplug MicroSD card and use a pin and press the
Reset button at the bottom of camera

> Reconnect your camera and press O

ULTIMATE SOLUTION

> Make sure you are using the original car charger that comes with
the package. If not, please replace.
> Remove the rear camera, MicroSD card, and GPS holder, and then
put them back into the dash cam in sequence. Check whether the
short circuit of the accessories causes the dash cam to fail to work
normally.
> Check your MicroSD card is U3 Class10, if not, please change to
one thatis U3 Class10.
> If not, please use your personal USB charge and check again.
Check if the car charger is short-circuited and the dash cam cannot
work normally.
> Please download our latest firmware to upgrade your dash cam.
> If the methods above don't solve your problem, feel free to contact
Redtiger and please leave your contact information and current
address which may be needed if a replacement is warranted.
This solution could be dealing with multiple problems > Won't
turn on > Restart itself > MicroSD card error > Can't auto recover >
Can't playback
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Trouble Shooting
I e — et

How to update the firmware

Download URL: https://www.redtigercam.com/pages/firmware-1
The upgrade steps:
> Download the correct firmware to the computer.

> Copy the firmware called "FWQ70A" to the root directory of the
MicroSD card. (The file name cannot be modified)

> Insert the MicroSD card into the machine, then insert the power
cord and short press the power button (do not turn off the power
during this process)

> During the upgrade process, the blue light is always on and the
red light is flashing. After the upgrade is completed, the machine will

automatically turn on.

Operation video: https://youtu.be/IMz1g309SPE

Firmware download URL Operation reference video
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Customer Service
—

WORDS FROM HEART

‘ Since our products are related to the safety of customers, we are
committed to producing the best product quality and high-quality
after sales support.

In view of no product is flawless, we sincerely believe the true
measure of the company'’s character is what it does *after* its
product does not meet expectations, we feel sorry for those
customers, but deeply grateful for them to make us one more
step closer to your most trustful automotive after-market brand.

We are willing to provide 1 month free return for your product, 1
year limited warranty, and lifetime technical support. Your product
is guaranteed to be free of defects in materials and products from
the date of purchase. In addition, you can also exchange your 1
year old product for a discounted price by contacting us online.

Behold the motif of complexity to us, simplicity to others, it's such
a pleasure to listen to your advice, and we will promptly address

any problems that arise.

Redtiger Customer Service Team.

[ |
N’
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Customer Service
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WhatsApp

AT

Facebook

Email

Mirror Dash Cam

Email: support@redtigercam.com

Mini Dash Cam

Email: help@redtigercam.com

Business Cooperation or Others Email: contact@redtigercam.com

Customer Phone Service: +1 888 966 8028 (US)
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Product Information
— =

BASIC INFO OF YOUR CAMERA

Model > F7NP
Display > 3.18 inch IPS
Input > DC 5V-2.5A
Aperture >1.5
Battery > Super capacitor
Video Format > Video: MP4
Still image: JPG
Loop recording > 1/3/5mins
Recording method > Normal recording/Emergency recording
Screen View > Front & Rear view/Front view/Rearview
Resolution > Front 3840*2160P
Front 2560*1440P

Front 2160P+Rear 1080P
Front 1440 P+Rear1080P

GPS > Yes

Audio >Support sound recording and play back
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Product Information
— =

BASIC INFO OF YOUR CAMERA

G-sensor
MicroSD card

Record photo

Temperature

Warranty period

> 3 Axis G-sensor
> MicroSD 32GB-256GB

> Main body display/Computer/
Smartphone

> -4°F-158°F

> 1 Year
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About Us

In an automobile-interconnection era,
everything about charm journey is within the reach of eyes.

Product and service are the foundation of Redtiger.
We have an expert research and
development team of "self-driving experts".

Based on the personal needs of users,
we use technology to drive product innovation.
In the future, we will continue
to explore the boundaries of tech to open up
a broader vision for driving.



